TigerTrak TM-1 & TM-1+ Tracking Modules
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- INTRODUCTION -

The TigerTrak TM-1 and TM-1+ are highly sophistiat
fully programmable, tracking and telemetry modulEsese
units have been designed to meet the most stringe
requirements of both the commercial and amateur. T$e
TM-1 employs the latest in high density "surfaceumtt
technology, assuring high reliability and compaze s

The standard TM-1 Tracker features a single "Tragki
mode that can be configured for APRS® compatibillthie
TM-1+ "MultiMode" Tracker supports the basic trawdi
mode of the TM-1, plus several additional modes fo
specialized tracking and telemetry applicationsdifidnally,
the TM-1+ includes solid-state power switching fan
external device like a GPS. This allows OEM GR&ieers
like the Garmin GPS-35 to have their power contabll
directly by the TigerTrak. Both TM-1 models emplthe
latest in "Flash" microcontroller technology, aliogy
additional features and functions to be added witlaalding
additional hardware. Flash technology also alldwes TM-1

to be upgraded to a TM-1+ in the event your tragkin
requirements change! Both models come completel
assembled and tested and include an easy to usgoWsn
configuration program.

The TM-1 and TM-1+ are easily interfaced to mossdya
mobile, and hand-held radios. Since power consumps

extremely low, the units can usually be powerecally

from the "Aux Power” pin on the radios mic connecteor

APRS® and some other tracking applications, the Irig-
connected in parallel with the microphone. Thi®wal you

to use the radio for voice communications and fragck
simultaneously. It also allows the mic PTT to tegghe

tracker at the end of each voice transmission émanding).

Special circuitry in the TigerTrak allows it to "tel the

radios mic and control PTT operation without thedheo

breakany of the mic lines!
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- COMMERCIAL APPLICATIONS —

Our most fundamental goal in the design of thig wais to
create a flexible and fully programmable platformwhich

a wide variety of other devices could be built. eTh
TigerTrak is just the first of many products thall e built
on this technology. The basic design of this umgtkes it
extremely easy and inexpensive to adapt to a custom
application. The use of multiple Flash based @Bsoes
allows us to inventory finished boards which can be
programmed to become a variety of products on a enten
notice. Every aspect of this devices productikesaplace
within our own facility. We fabricate the extrudedse,
injection mold the covers, NC mill the openings, kena
artwork, silkscreens, tooling and even do the rigbot
assembly under one roof! All of this makes it veasy and
economical for us to adapt the unit to your speoneegds.
We are a full service quick turn solution. If ybave an
application that we might be able to adapt thig tmi we
invite you to discuss it with our engineering staff

- ABOUT THIS MANUAL —

Because the TigerTrak’s setup varies widely witbheaf its
operating modes, this manual will focus mainly esuies
common to all modes. This includes general infaiomaon
installation, operation, and specifications, asl|wad an
overview of the TigerTraks main operating modestaied
information for setup of specific modes will be eoed by
the on-line HELP files included with the Configuomt
Program. Having these details in the ConfiguraBoogram
allows the information to be regularly updated by
downloading new help files from our web site. Yoan
obtain HELP at any time when you are using the nogby
placing the cursor in the field of interest andssieg F1.
Access to the entire HELP database is availablm ftoe
Help Menu at the top of the screen.

- WHAT YOU WILL NEED -

In order to program the various functions of thgeFirak
you will need to connect it to an IBM compatiblenguuter
running Windows 95 or Windows 98 and the Configorat
Program that we have supplied. Note that our @rogwill
not operate with earlier versions of Windows or niro
MSDOS. Your computer must have a free serial pothe
range of COM1 to COM4. To connect the TM-1 to your
computer, you will need a standard serial interfaable.
Figure-1 shows the wiring of the cable. Note thally four

of the nine lines are required.



Computer T™-1

DB-9F (DB-25F) Receive DB-9M
Receive Data 2 (3) O O 2 Transmit Data
Transmit Data 3 (2) O O 3 Receive Data
Request To Send 7 (4) O O 7 Request To Send
Ground 5 (7) | O QO |5 Ground

Figure-1 TM-1 to computer interface cable

The TigerTrak is supplied with a radio cable thas hhe
connector already installed on the TM-1 end. Yallinveed
to provide whatever connectors are necessary &zhathe
other end to your particular radio. If you areiagrthe TM-
1 to a dedicated radio (no microphone), you withgly need
to attach the appropriate connectors to the entieotable.
If you are using the TM-1 as a APRS® tracker and gfso
want to use the radio for voice communicationsntlgeu
will need to attach the TM-1 lines in parallel withe
existing microphone lines. Tigertronics offers @ptional
Mic Adapter Kit that will greatly simplify this pess.
Refer to the section on “Connecting Mobile & Datadi®s”
for additional details.

- INSTALLING THE SOFTWARE —

Before you can use the TM-1 you will need to progria

using the Configuration Program that we have predid
This program may have been supplied on either flafipks

or CDROM, but the installation procedure is the sdor

both. The software must be installed on a computening

either Windows 95 or 98. Before installing the gmaim you
should review the README file on the installatiomskl

This file contains important information that yoliosild be
aware of before installing the main program.

To install the Configuration Program follow theseps:

1) Click on the Windows “Start” Button.

2) Click the Run Button.

3) Click Browse and select the disk drive where thg
TM-1 software is located (Floppy or CDROM).

4) Click on the program named SETUP.EXE.

5) Press OPEN.

6) You should now be back at the RUN menu wherg
you simply click OK to start the installation
process. Follow the directions that appear.

After installation is complete and you are using pinogram,
you can obtain HELP at any time by placing the cuns the
field of interest and pressing F1. Access to thtgree HELP
database is available from the Help Menu at thedithe
screen. Basic instructions on how to configureTthe1 can
also be found in the “Configuring The TM-1" sectiohthis
manual.

- CONNECTING POWER -

The TM-1 requires an unregulated source of 8 to[1G\at

approximately 45 milliamps for operation. Powen dae

supplied through either the “Ext Pwr” connector tlmough
Pin "B” (black wire) on the radio interface connaci{RJ-
11). Power from these two sources is handled reifiity
inside the TM-1, so the connection you select délpend on
your application. A description of each power opti
follows. Figure-2 will help you understand the TN&
power routing circuitry.

DB-9 Fin #49

Il i o To Voltage
Ext. Poarer Irpat % . {1 l > elat

FJ-11 Pin #2
Figure-2 Power Input Circuit
WARNING: Incorrect power wiring can destroy the T
and the equipment that it is connected to. ALWAYSe a
fuse in the power line. Be sure to read this estisection
before applying power!

External Power Connector — External power can be

applied to the TM-1 through a 2.1mm coaxial power

connector on the rear panel. This power inputeigerse-
voltage and over-current protected. A PTC selétasy
fuse limits the input current to a maximum of 300niBhe
high current rating of the fuse was chosen so tthiatinput
could also be used to power a GPS or other telgrdetrice
through Pin #9 of the DB-9 connector on the Datat€n
port. See “Powering A GPS Receiver” for more infation.

Radio Interface Connector- Pin “B” (black wire) on the
RJ-11 radio connector provides another means gilging
power to the TM-1. Extreme caution must be use@rwh
connecting power to this input, as itN©T reverse-voltage
or over-current protected. Before powering theeflgak

from the mic connector, you must check the radios

documentation to be sure that it is safe to dramal5 You
must also verify that the voltage available on timic
connector is in the range of 8 to 15 VD®Varning: You
can cause permanent damage to your radio by ovetlog
its Aux Power output!

To power the TM-1 from your radio, you will need to
connect the RJ-11 Radio Interface lines as follows:

Pin “A” (White) - Chassis Ground
Pin “B” (Black) - Accessory Voltage
Pin “F” (Blue) - Signal Ground

To activate the power pin on the Radio Interfaca yall
also need to install a jumper on “JP-3" of the f@ihcircuit
board. This jumper is located near the Ext PwK jaic the
board.



Warning: Some RJ-11 cables do not have the wires|
arranged in the proper order or may have the contwc
installed backwards! Refer to Figure-3 below fohed
proper connector and cable layout.

(Rear View)

0000

/ N

NN

AWht) BB C(Red) D(Gm) E(Yel) F(Blu)
Ground Power PTT RX Audio TX Audio Ground

Figure-3 Radio Connector

Power During Programming —When you attach the TM-1
to your computer for programming, you will needstapply
operating power. The easiest way to do this iplbgging a
DC Wall Transformer into the Ext Pwr jack. Be sthrat the
transformer you use supplies a voltage betweend 1d&n
volts. Note that some wall transformers put outessive
voltage when they are operated at lower than thedra
current, so it would be wise to measure the actoithge
output before plugging it into the TM-1. If a wall
transformer is not available, you can also power dimit
from a 9 volt battery or bench supply.

Powering A GPS Receiver The TM-1 can supply power to
a GPS receiver or other device through Pin #9 an th
Data/Control connector. In order to do this the-Thust
be powered through the Ext Pwr connector (notRAell)
and the pc-board jumper labeled “JP-1" must beallest.
This jumper is located next to the Ext Pwr jackiom pcb.

The power available on Pin #9 when JP-1 is ingal&e
limited to about 250ma by a PTC fuse. On a TM- th
power is available any time power is applied to Ex¢ Pwr
jack. On a TM-1+ the power to Pin #9 is controlled a
solid-state switch. The switch is turned on ametithe TM-
1+ is ON. This is especially useful for controflipower to
an OEM GPS receiver like the Garmin GPS-35, whiak h
no manual controls. Using this feature, the GPS i
automatically turned ON and OFF with the TigerTra®n
both the TM-1 and TM-1+ the power at Pin #9 is
unregulated and is approximately 700mv lower thhe t
power applied to the Ext Pwr jack. This voltagemlis due
to the polarity protection diode on the jacks inpugefore
powering any device from the Data/Control connectm
sure to verify that the device can be safely pod/dérem the
voltage that you are applying to the Ext Pwr jackhe vast
majority of GPS receivers can be powered fromsbigce.

oY

- CONNECTING MOBILE & DATA RADIOS -

The TM-1 attaches to the radio through a 6 wirelRJ-
connector on the rear of the unit. We have sedmi length
of cable for this purpose with your TM-1. The aablready
has the RJ-11 connector installed in accordande Figure-
3. If you intend to use a cable other than the thia¢ we
supplied, make sure it is configuretkactly as shown in
Figure-3 and read thé&arningabout these connectors. You
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will need to wire the unterminated end of the catgeording
to the documentation supplied with your radio.

Only five connections are required to attach the-Thb a
radio. These connections are PTT (Red), Transmdid\
(Yellow), Receive Audio (Green), Chassis Ground {féh
and Signal Ground (Blue). If you are powering iHd-1
from your radio, then an additional Power wire @pis
also required. Most radios of recent manufactuitehave
all of these signals (including Receive Audio) #alie on
the microphone connector. On radios that don’tehav
Receive Audio available on the mic connector, itl Wi
necessary to run a short jumper cable to the rdehsrnal
Speaker jack.

Exactly how you connect the TM-1 to your radio wi#pend
on your application. For dedicated telemetry aratking
applications (no microphone) you can wire the calidectly
to the appropriate pins on the radio’s mic/dataneator as
shown in Figure-4.

Radio
RJ-11 A Wht O Gnd (Pwr)
B (BIk)
O Acc. Voltage
C (Red)
D (G
(Gm) O Speaker Out
A, E (Yel) .
e] Mic Input
F (Bl
(Bl) ) Gnd (Mic)

Figure-4 Wiring diagram for data-only applications

In applications where the TM-1 will be connectedatoadio
that is being used for both voice and tracking,Tive1 must
be connected in parallel with the microphone asmvshm
Figure-5.

A (Wht)
B (BIK)
C (Red)

lru]E=——""06m
e

F (Blu)

To TM-1

Mic

Gnd (Mic)
TX Audio

RX Audio
PTT

Power
Gnd (Pwr)
N/A

N/A

0O 0O 0O 0O 0O 0O O o

Figure 5 - Wiring diagram for data/voice applicato

Getting connected in parallel with the mic conneci®
generally not as simple as it sounds! The easwstion is
to make some sort of “Y” cable that splices intee th
appropriate lines. Unfortunately, this solutiomds to be
both cumbersome and unreliable. A better choiceois
provide a junction box with connectors for all tharious
devices and a terminal block to allow selectiortref lines



going to the TM-1. Tigertronics now offers an optl Mic
Adapter Kit for this purpose. The kit includes dfie
necessary cables and connectors for both 8-Pirdrand 8-
Pin RJ-45 type mic connectors. Additional detatb®ut the
kit are available on our web site. A picture o€ tMic
Adapter pc-board is shown in Figure-6.

Figure-6 Mic Adapter PC Board

- CONNECTING A HAND-HELD RADIO -

If you are using the TM-1 with a hand-held radiouymay
find that there is no separate PTT line availabldany of
these radios key the PTT by grounding the microphoput
line through a resistor. If this is the case wtur radio,
you can activate the TM-1's internal PTT keyingists
(2.7K) by installing jumper “HT” on the pc-boardThis
jumper is located near the RJ-11 connector ondhe of the
unit. Note that all radios will work with the ke resistor
value we have provided, including those from maciufigers
that suggest a higher value. If you select therkgyesistor
option, be sure you do not attach anything to th& fRed)
line on the interface cable. On radios that hawearate
PTT line (ie: Kenwood, etc.) be sure that the “Hdrhper is
not installed. NOTE: Because the antenna on most-han
held radios is only a fraction of an inch from whehe
cables plug in, we recommend using an externahaatd at
all possible. This will prevent excessive RF lsvéiom
interfering with the operation of the TM-1 and GiReSeiver.

- THE DATA/CONTROL INTERFACE -

The Data/Control connector on the rear of the Tkkh be
used to connect a variety of external data souregading
GPS receivers, Programmable Logic Controllers, Warat
Instruments, and Security Systems. The interfaceaccept
both RS-232 and CMOS logic levels. Input baud caie be
programmed to 1200, 2400, 4800 or 9600 baud. HEte d
format is configured for eight data bits, no pariyd one
(or more) stop bits. Figure 7 shows how to contteetTM-

1 to various types of serial devices.

GPS T™M-1
DB-9F DB-9M

Transmit Data| &

O | 3 Receive Data
Ground | © O | 5 Ground

O [ 9 GPS Power

Power Input | O

Data Device T™-1
DB-9F DB-9M

Transmit Data| O O | 3 Receive Data
Ground | & O [ 5 Ground

Figure-7 Connecting the TM-1 to various devices.

- TEST MODE OPERATION -

The TigerTrak's Test Mode has two main functioférst, it
can be used to generate nearly continuous paaketssting
or calibration of deviation. The test message ist&1®f the
station call sign followed by a very long stringntaining all
printable ASCIl characters. Once started, thengtris
transmitted continuously until power is turned O&FPC
MODE is invoked. PC MODE is the mode that the TM-1
uses to communicate with the PC during configuraaad
setup. Anytime the TM-1 is running in Test Motiésialso
looking for a PC running the Configuration Prograkivhen
the PC is detected on the Data/Control port, ipdrout of
Test Mode and enters PC Mode automatically.

To start Test Mode you must simply be pressingMuoele
Switch when you turn on the Power Switch. As saserihe
Power LED lights, you can release the Mode Switdtou
will notice from the PTT light activity that you e started
sending the Test Mode beacons. If you subsequatitigh a
computer running the Configuration Program, the TMill
automatically detect it and enter PC Mode. Theegre
“Lock” light will illuminate to indicate that PC Mde is
active. The only way to exit PC Mode is to turnFOthe
unit. This happens automatically when you press
Disconnect” from within the Configuration Programwehen
you EXIT the program. Never disconnect power tmtu
OFF the TM-1 when it is running in PC Mode.

- CALIBRATION -

All critical functions within the TM-1 are contreltl by a
precision crystal and will never require -calibratio
Normally, the only adjustment that may be requibgdthe
user is the “LEVEL" adjust on the front panel whisbts
transmitter deviation. While the level has beentdsy
adjusted to the correct setting for most radiosre¢hmay be
instances where further adjustment is necessary.suth
cases, the level should be set to provide a tratemi
deviation of 3.5 to 4.0 KHz. In most cases, theeo
deviation is better. Note that this is less déeratthan
would be appropriate for voice communications. Tdwer
deviation provides superior phase distortion charéstics
for data transmission and minimizes data errors cdlibrate
the modulation level you will find it helpful to ate the TM-
1in Test Mode.



- CONFIGURATION PROGRAM OVERVIEW -

Getting Connected -To configure the TM-1 for operation
you must attach it to your PC and a power source §
mentioned in earlier sections. Before you stadca@hnect
the TM-1 from your radio so that it does not traitswhen
you enter Test Mode. Start the Configuration Paogion
the PC and then place the TM-1 in Test Mode. Thdone
by holding down the Mode button when the Powerdsuis
turned ON. You should see the “Disconnected” buitothe
program switch to “Connected” after a few secondshe
green “Lock” light on the TM-1 will also illuminateo
indicate that it has entered PC Mode and is reauy f
programming. The type of unit (TM-1/TM-1+) and cemt
firmware revision will be displayed at the top bktscreen
after connecting.

Reading and Writing - The Configuration Program is
capable of both reading and writing to the data orgnof
the TM-1. Once you have established communicadioth
the program displays “Connected” you can read thells
current mode and configuration details by pressihg
“Read” button. After you have changed the configion,
you can write it back to the TM-1 by pressing thWrite”
button. It is important that you never disconnpoiver
while the unit is communicating with your PC!

If you have connected to the TM-1 just to verifysit
configuration and do not plan to program (Writejvndata,
then you should press the “Disconnect” Button tm tOFF
the TM-1 before disconnecting any cables.

The File Menu — The File menu of the Configuration
Program allows you to manage the various configumat
that you create for the TM-1. The first three stitms allow
you to Create, Retrieve, and Save all your conéijon data
to a disk file.

The Memorize Defaults button writes the most comiymon
used parameters in the program to an initializafilenvhich
loads automatically when the program starts the time.
After you have created your first configuration yshiould
click the Memorize Defaults button so that the paog will
remember all of your basic defaults like My Cakrial Port,
Baud Rates, etc.

The last selections in the File Menu allow you tinppa
handy Pocket Guide to help you remember your ggttin
NMEA and Tracking Modes. These modes are very
complex and contain may Profile settings. You ¥l this
feature a valuable tool to manage your unit infiglel.

The Setup Menu —This menu allows you to select the
various communications parameters for the progravou
must select the Serial Port that the TigerTrak waé
connected to during configuration. There are s$ieles for
COM1 thru COM4. You will need to consult your

computers documentation to determine which port is

available for use. Our factory default is COM2.

You will need to select an Input Baudrate from thienu
also. This is the baud rate for the data that béllreceived
by the TM-1's Data/Control port. For GPS receivéis
baudrate is usually 4800 baud. Baudrates of 12@00,
4800, and 9600 are available to interface to a wadesty of
telemetry and data equipment.

You will also need to select an Output Baudratenfrine
menu. The TM-1 is capable of generating both 3A0 a
1200 baud packets. The 300 baud selection sheuldrglly

be selected for HF operation, while the 1200 baaldcsion

is normally used for VHF and UHF. Note that thixsome
1200 baud packet activity on the 10 meter HF band.
Commercial users will almost always require 1200cha

The Help Menu — Selecting the Help Menu provides you
with access to the entire HELP database. It allpas to
Search, Browse, and Print the available informatidiote
that you can also get help for a specific fieldaay time by
placing the cursor in that field and pressing thek&y.

Detailed Mode Settings— Detailed information concerning
the various entry fields within each mode is avddafrom
the online HELP menu. We will make every attenapkeep
expanding the scope of the HELP file and make dtilatle
for download on our web site at: www.gpstracker.coifhe
TigerTrak is a very complex product and the usexjsected
to have a working knowledge of his application. r Fo
example: We make no attempt to explain the apjpicaor
intricacies of APRS®, although the TigerTrak suppdhis
type of operation. It is the users responsibilitydetermine
his objectives and the proper protocols for operati In
some cases a user unfamiliar with a particular iegibn
may need to seek the assistance of a more expedenc
associate or even a professional. Our Technicpp&ti is
available to answer questions related to the haelwad
configuration software, but is not available to \pde
extensive support for any application, except @omsulting
basis.

- MODES OF OPERATION -

The TM-1+ currently has five different “Modes” of
operation, while the TM-1 is limited to operationTiracking
Mode only. Note that the TigerTrak can only operatone
mode at a time! An overview of each mode follows:

Telemetry Mode- This mode is best suited for applications
in which the data to be transmitted arrives in tsuré\s each
data burst is received it is stored in memory fangmission
when the burst is complete. By buffering the datahis
manner, the unit can accommodate data that isiragriat
baud rates both faster and slower than the tras&misate.
The end of the burst is detected by the receptibra o
“termination character”. This is a user specifidtharacter
that is known to be at the end of the data stred@gpically
this character is a Carriage Return or Line FeBdt it can
be any character that you select between 00 arftekF The
only requirement is that the character can nevest ex
anywhere in the data string except the point atclwhi
transmission should be triggered. The transmifelbutan



hold as many as 105 characters. If the bufferftoxes, data
storage will stop and transmission will be suspenail the
termination character is received. A transmit time
provided in this mode so that data can be transdittt a
user-defined interval. The interval can be seany value
between 1 second and 68 minutes. Multiple patles a
supported. These paths can be used to routeathentission
through a repeater network or to identify the segdievice
with ID Codes.

Beacon Mode- This mode is used in applications where 3
fixed message must be transmitted at regular iatervThe
interval can be set to any value between 1 second68
minutes. The length of the “Beacon Text” is limitto 76
characters. This mode is ideally suited for trattsmg an
APRS® string from a fixed (base) location, so it @ppear
on local APRS® maps. It is also useful for trarting
announcements like severe weather warnings, meetig

NMEA Mode - This mode was designed primarily for GPS
tracking applications, where entire NMEA sentenuesd to
be sent. However, this mode can also be used yn a
application where the desired data is identifiedabknown
preamble (header). In operation the incoming data
searched for a predefined string (Data Header).emthe
string is received, the unit starts storing datadrbuffer. It
continues to store data until a user specified itetion
character is received or until the buffer overflow§ he
buffer length is 105 characters. This is suffitietong to
store any NMEA string. The user can program ughtee
Data Headers to search for. A header can be ugixto
characters long. The unit searches for and traasesich
header in sequence. A transmit timer is provigethis
mode so that data can be transmitted at any udieede
interval between 1 second and 68 minutes. NMEA &od
allows the user to configure up to ten differentdfites”,
each with it's own SSID, Digi Path, Transmit Timeterval,
TX Delay and Tail Delay.

Tracking Mode - This mode was designed especially for
tracking applications where shorter packets areratss.
This mode is flexible in its format and can be égufed to
transmit APRS® compatible strings. In operatioa serial
input receives $GPRMC NMEA strings from a gps reeei
and parses out the latitude and longitude data etked
construct the packet. The user can specify sever
parameters that are included in the packet inctudin

“comment” to be attached to the end of the packet.

Transmission of the packet can be triggered byasglef the
microphone’s Push-To-Talk button (mic encoding/nanu
mode) or by an automatic transmit timer (auto mod€he
timer interval can be set to any value betweencbrsd and
68 minutes. This mode allows the user to configuréo ten
different “Profiles”, each with it's own SSID, Digpath,
Symbol, Transmit Timer Interval, TX Delay and Taglay.

Alarm Mode - This mode allows the remote monitoring of
up to four alarm conditions. In this mode the TM-1
continuously compares the state of the alarm infouts user
programmed “image”. If the state (High/Low) of aimput

deviates from the “image”, then the alarm is ad#da

Alarm activation causes a user-defined packet tosédmat
identifying the alarm condition. If multiple alasmhave
triggered, then multiple messages will be sent. aril
packets are sent a specified number of times ana at
programmed interval. After all transmissions esenpleted,
the TM-1 will reset the alarm status (“image”) bdsm the
current state of the inputs. If the condition thmtiated the
alarm still persists, then the alarm will still teset using the
current set of conditions ( i.e.: the alarm wilbtnbe
triggered again unless the door that was openeer lat
closes!). The alarm messages are programmed bystre
The message for Alarm #1 can be up to 25 charaldegs
The remaining three messages are limited to 15actexs.

- ABOUT PROFILES -

Both the NMEA and Tracking modes allow up to ten
separate “Profiles” to be programmed into the TME&Ach
profile has it's own SSID, Digi-Path, Transmit Intal, TX
Delay and Tail Delay. The other information usedttese
modes (MyCall, ToCall, etc.) is shared among allthod
profiles. Each profile can be selected by the us#hre field,
without the need for a computer. This is usefuitnations
where the operator is driving from one area to laagtand
needs to switch the Digi path from a local pathatonore
generic one. It is also a convenient way to chatimger
intervals for changing situations, like when yoa ao longer
moving.

A profile can be selected by simply pressing theotid”
button a number of times that is equal to the prafumber
that you want to use. For example, if you wantsédect
Profile #5 you would press the Mode button five ésn
After selecting a profile, the TM-1 will verify yoselection
by flashing the “PTT” light a number of times equalthe
profile number selected. The current profile iwals saved
to memory when the TM-1 is powered off. Upon powpr
the current profile is loaded from memory and tA& Right
is flashed to indicate the profile number currergifected.
Turning the unit On/Off is a handy way to readohé t
current mode. Profiles are one of the most powésatures
of the TigerTrak. They allow you to overcome many
common problems that plague other tracking devices.

- FIRMWARE UPGRADES -

Tigertronics may from time to time offer firmwarer o
hardware upgrades to enhance the features andoisaif

the TigerTrak. These upgrades will be announcedun
web site. If you are interested in a particulagnage, you
should contact our Technical Support Department to
determine the cost and proper return procedure=snef@ally
upgrades do not involve hardware changes, so tteyay
simple and inexpensive.

- TECHNICAL SUPPORT -

If you read this manual and the Help Files in the
Configuration Program thoroughly, it is unlikelyathyou
will need additional support. You can also findswaars to
many common questions on our Internet web site at:



www.gpstracker.com. If you do encounter a probkat
you cannot resolve, you are welcome to call ourhheal
Support Hotline at (541) 862-2639This line is available
each Monday, Wednesday, and Friday between 1:00 PM
and 5:00 PM Pacific Time Be sure to have your
equipment available for testing when you call. aB& DO
NOT mail, email, or fax your technical questioasus. We
realize that calling is a little more expensivet fmore can be
accomplished in a few interactive minutes on thenghthan
can be accomplished in hours of writing! We simgtg not
able to respond to written inquiries involving taeddal
problems.

- VISIT OUR WEB SITES -

If you have Internet access, please be sure toousitracker
web site at: www.gpstracker.com and our main wéb ai:

www.tigertronics.com These websites contain theesta
news about Tigertronics products as well as a Wweaft
information including Software Updates, Applicatibiotes,

Frequently Asked Questions, and other technicakiss

- YOUR COMMENTS WELCOME -

Tigertronics has made every effort to make the fMigek the
best product possible. We believe it representsagor
technological breakthrough and hope we have aatieth
your every need in using it. We welcome any contmen
suggestions that you would like to make. Pleasgp dis a
note to let us know about your experiences, tips would
like to share with other users, or how we mightadbetter
job for you.

- LIMITED WARRANTY -

Tigertronics warrants the TM-1 to be free of dedeat

material and workmanship for a period of 90 daysnfithe
date of shipment. Tigertronics will repair or rapt, at its
option, any parts found to be defective during waeranty
period. This warranty does not include any uniiclwhhas
been subject to misuse, neglect, improper instaitiabr

operation. This warranty is in lieu of all otheexpress or
implied, and no person or representative is awthdrito
assume for Tigertronics any other liability in cention with

the sale or use of this product. Tigertronics widlt be
responsible for any expense or loss of revenuerapguty
incurred by the user due to operation or malfumctié this

equipment. Tigertronics reserves the right to makeuit or

component changes, or to incorporate new featateany
time, without obligation.

- RETURN POLICY -

A Return Material Authorization Number (RMA#) muse¢
obtained from the factory before any product wikk b
accepted for return or repair. Items receivechatfactory

without an RMA# clearly marked on the OUTSIDE oéth
package WILL NOT BE ACCEPTED. Items being returned
must be sent prepaid. Returned items should hateg
attached showing the RMA#, customer name, retudness,
phone number, and action requested. Units beingned
for warranty repair must be accompanied by a cdpthe
original sales invoice showing the date of purchase

Customers wishing to return a product for refurad, ANY
reason, must receive an RMA# within 15 days frora th
shipping date shown on the original sales invoZgstomers
returning products for refund will be charged a tBelsing
Fee equal to 20% of the purchase price, to covecdst of
re-testing and re-stocking. Products which havenbe
damaged or modified in any way, may not be refirne
Contact our Technical Support department for theA&M

- FCC STATEMENT -

S/N 000000

This device complies with Part 15 of the FCC Rule.
Operation is subject to the following two condisorfl)
this device may not cause harmful interference (anthis
device must accept any interference received, dioty
interference that may cause undesired operation.

NOTE: This equipment has been tested and foudnaply
with the limits for a Class B digital device, puasti to Part
15 of the FCC Rules. These limits are designeprbwide
reasonable protection against harmful interferemtea
residential installation. This equipment generatsgs and
can radiate radio frequency energy and, if notalfest and
used in accordance with the instructions, may chassful
interference to radio communications. Howeverrdtie no
guarantee that interference will not occur in atipalar
installation. If this equipment does cause harmful
interference to radio or television reception, whizan be
determined by turning the equipment off and on,uber is
encouraged to try to correct the interference by ohthe
following measures:

Reorient or relocate the receiving antenna.
Increase the separation between the equipment and
receiver.

Connect the equipment into an outlet on a circiffieiknt
from that to which the receiver is connected.

Consult the dealer or an experienced radio/TV tecdum
for help.

Caution Changes or modifications not expressly approved
by the party responsible for compliance could vbiel users
authority to operate the equipment. To meet FCC
requirements, shielded cables are required to @brihés
device to a personal computer or other Class Bifieelt
device.



- TECHNICAL INFORMATION -

- THE RADIO INTERFACE -

The radio interface is terminated with standardi@wRJ-11
connector. Note that we have identified the vagitines
with letters rather than the customary pin numkersde
consistent with the identifiers used on our Mic At
board. Figure-3 shows both the pin letter designatand
the corresponding wire colors. The signals on itftisrface
function as follows:

Pin “A” (White) — Power Ground This is the ground return
line for TM-1 power. It should be connected to thaeios
power or chassis ground pin on the mic connector.

Pin “B” (Black) - Accessory Voltage Input This line can
be used to power the TM-1 from the “Auxiliary Vajel
available on the mic connector of most radios. Vbkage
on this input must be between 8 and 15 VDC
Approximately 45ma is needed to power the TM-1¢e 8
“Connecting Power” section of this manual for funth
information on the jumpering required and precagio

Pin “C” (Red) — PTT This line is used to “key” the
transmitter. The TM-1 switches this line to grounith a
FET transistor during transmit. The transistor ¢simk”
currents as high as 50ma @ 12 volts. When intedaalder
radios that use mechanical switches (relays) in RAG
circuit, precautions must be taken to insure tirdtage and
current limits are not exceeded. If your radio de&some
other kind of keying arrangement (not likely) yoillweed
to provide it. If your radio is an older model Wihigh
voltage or high current on the PTT line, you widted to
install a small relay to do the keying (very lowrmant 12v
relay). Special provisions have been made to ey T of
some “hand-held” radios. See the “Connecting Hidett
Radios” section for details.

Pin “D” (Green) - Rx Audio This is the receive audio input
to the TM-1. This line is used to detect chanrzivay
prior to transmitting. This line is normally coruted to
speaker audio and has a nominal input level of 250mp.
This input can be optionally configured to dete®@@ level
for use on some data radios. Refer to the “Opliampers”
section for further details.

Pin “E” (Yellow) - Mic Audio This is the transmit audio
output from the TM-1. The output is capacitivelyupled
and should be connected to the microphone inputhef
radio. The level on this output can be adjustedthsy
“LEVEL” control on the front of the TM-1. The leldés
adjustable from zero to 80mv p-p (Hi Z). Note ttia level
has already been factory adjusted to be compatiitfemost
radios. You should not attempt to re-adjust thellgvithout
the proper test equipment. Deviation should be teet
3.5KHz for most applications.

Pin “F” (Blue) — Signal Ground This is the microphone
ground from the radio. It should be a separatemptdrom
the power ground.

Radio Interface Notes:

1) Keep the lines between the radio and the TM-&hast
as possible to prevent unwanted noise from entéhiag
mic circuit.

2) If you are using a radio cable that was not Bagpoy
Tigertronics, be sure to verify that the connector
orientation is correct using Figure-3. It is ertedy
common for the connector to be installed backwards!

3) Be sure that the cable you use has a high guzdid
plated connector that has been installed with fieer
crimping tool. Lesser quality cables, availablenir
many retail outlets may not provide reliable opierat

Connection Summary:

Pin “A” (White) - Power Ground

Pin “B” (Black) -  Accessory Voltage Input
Pin“C"(Red) - PTT

Pin “D” (Green) - Rx Audio

Pin “E” (Yellow) -  Mic Audio

Pin “F” (Blue) -  Signal Ground

- THE DATA INTERFACE -

The data interface to the TM-1 is a standard DEf@&ale)
connector. The signals on this connector functam
follows:

Pin “1" — Alarm Input #1 This alarm input is high
impedance and CMOS level compatible. It is intbyna
biased to the high (+5v) state and is low-passréi to
prevent false triggering. Applying logic levelsomply
grounding this input will activate the alarm.

Pin “2” - Transmit Data This line is the serial data output
from the TM-1. It is used exclusively by the cortgru
during programming of the unit. It should not lmmeected
for other applications. Output levels are RS-28&gatible.

Pin “3” - Receive Data This is the serial data input to the
TM-1. Data from a GPS or other telemetry deviceusth be
connected to this pin. The input will accommodziteer
standard RS-232 levels (+/- 12v) or CMOS logic Isve
(O/+5v). This input is high impedance.

Pin “4” — Alarm Input #4 This alarm input is high
impedance and CMOS level compatible. It is intbyna
biased to the high (+5v) state and is low-passréid to



prevent false triggering. Applying logic levelssomply
grounding this input will activate the alarm.

Pin “5” — Ground
signal ground.

This pin is used for both power and

Pin “6” — Alarm Input #2 This alarm input is high
impedance and CMOS level compatible. It is intbyna
biased to the high (+5v) state and is low-passréid to
prevent false triggering. Applying logic levelssmply
grounding this input will activate the alarm.

Pin “7” — Programming Supply This line is used to supply
negative voltage to the RS-232 driver during progreng
of the TM-1 by the computer. It is not connected d&ny
other application.

Pin “8” — Alarm Input #3 This alarm input is high
impedance and CMOS level compatible. It is intbyna
biased to the high (+5v) state and is low-passréid to
prevent false triggering. Applying logic levelssomply
grounding this input will activate the alarm.

Pin “9” - GPS Power This optional output can be used to
supply power to a telemetry device or GPS receigse the
“Connecting Power” and “Option Jumpers” sectiontlas
manual for further information on the jumpering uggd
and for some important precautions.

Data Interface Notes:

1) Some devices that generate high levels of éattr
noise may not be suitable for connection to GPSdPow
line (Pin #9). The noise spikes generated by suc
devices may cause ground currents that generate moi
the transmitted signal.

Connection Summary:

Pin“1" -  Alarm Input #1
Pin “2” - Transmit Data
Pin “3" - Receive Data
Pin“4” - Alarm Input #4
Pin“5” - Ground

Pin“6” -  Alarm Input #2
Pin “7” - Program Supply
Pin “8” -  Alarm Input #3
Pin“9” - GPS Power

- OPTION JUMPERS -
- CAUTION - CAUTION - CAUTION - CAUTION -

Circuit board jumpers must be used with GREAT
CAUTION. Incorrect jumper settings can result in
IMPROPER OPERATION or DAMAGE to both the TM-1
and the equipment it is connected to!
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The TM-1 has several jumpers on the pc board for
accommodating special hardware requirements. Tivahet
the function associated with a particular jumpeyy ymust
short the jumper pins together using a 2mm "ShuBgveral
shunts were supplied with the TM-1 for this purposieyou
require additional shunts, you can obtain them frowst
electronic and computer suppliers, such as Mouger o
DigiKey. Tigertronics DOES NOT supply additional o
replacement shunts! With the exception of JP4 fdatory
default for all jumpers is "open". The jumpers aunbered
JP1 through JP5 and function as follows:

JP1 - WARNING: Be sure to REMOVE JP1 before you
connect the TM-1 to any device that might be damddne
voltage on DB-9 Pin #9 (computers, etc.)!

This jumper connects power from the External Pgaek to
Pin #9 of the DB-9 connector. This jumper can beful for
powering an external device such as a GPS or télgme
encoder. Note that in the TM-1+ the power to JB1 i
controlled internally by a solid state switch (PovikET).
This allows the power at Pin #9 to be switched ON
automatically anytime the TM-1+ is turned ON. e fTM-1
the power is not switched and is always applie®ito#9 if
JP1 is installed. Consequently, any device powmad Pin
#9 on a TM-1 must have its own power switch. Ithbine
TM-1 and TM-1+ the power to Pin #9 must be limited
250ma (Max). Any device powered through this jumpe
MUST be fused (250ma or less).

JP2 - This jumper is used to bypass the power switch.
Installing JP2 will cause the TM-1 to begin opergti
immediately when the power is applied. This mayubeful

in installations where power is controlled by amuttevice.
For example: If the TM-1 is used as a Mobile Texck
power could be supplied from the ignition switchtlat the
TM-1 is activated anytime the vehicle is in use.

JP3 - This jumper connects the input of the TM-1'seimial
voltage regulator to Pin “B” of the RJ-11 connectorhis
jumper can be utilized in two different ways. Eiiscan be
used to allow power from the radio interface (RJ-1d
power the TM-1. Secondly, because JP3 is at thet iof
the TM-1's power regulator, voltage applied to Ehdernal
Power jack will also be supplied to RJ-11 Pin “BJP3 is
installed. Note that a diode between JP3 and ttierial
Power Jack prevents power from RJ-11 Pin “B” from
feeding back to either DB-9 Pin #9 (via JP1) or External
Power jack. Power supplied to RJ-11 Pin “B” shobkl
limited to 100ma because of the limited power atiri the
RJ-11 connector itself. Note that power suppliedbugh
JP3 is not switched in either the TM-1 or TM-1+ef& to
Figure-2 for a better understanding of the powentrcd
circuitry.

JP4 - This jumper determines what kind of signal is
expected on the "Busy" line from the radio (RJ-11‘®").
The "Busy" line is tested by the TM-1 prior to tsamitting.

If the "Busy" line is active, the TM-1 will wait teransmit
until the channel is clear. This avoids collisionish other
signals that might be on the channel. The defiting for



JP4 is a jumper between pins 2-3. In this conéian the
input (RJ-11 Pin “D") is terminated with 100 ohmsdaan
audio level of at least 150mv p-p is expected wkiem
channel is busy. This is the correct setting 84 vhen
"Busy" is connected to the speaker output of aoradihe
alternate setup for JP4 is to connect pins 1-2is $atting
allows the input to sense a dc level. The dc ttolesfor
"Busy" will be about 2.5 volts and the input impada is
increased to 5k ohms. This option allows the "kdue
output” from most “data radio" ports to be usechisTis an
important capability since the audio from most &pbrts"
is not controlled by the squelch circuit.

JP5 - This is the "HT" jumper. Many handheld (HT) iasl

control the PTT function of the external microphamaut by

drawing a small amount of dc current through théi@u
(mic) input. This is generally accomplished by mecting a
resistor between the mic input and the PTT switcFhe

other side of the switch is connected to groundhsd a

small current flows through the mic circuit whee tATT is

activated. This current causes the radio to trénshumper
JP5 connects a 2.7k resistor between the PTT tio€uhe

TM-1 (RJ-11 Pin “C") and the mic audio line (RJ-PIn

“E"). This resistor value is suitable for all radi Note that
some handheld radios are NOT switched in this mafiree:;

Kenwood, etc.). Be sure to consult your
documentation before installing JP5!

radios

10

- GENERAL SPECIFICATIONS -

Levels (Radio):

Levels (Data):

Power Supply:

Operating Mode:

Compatibility:

Connectors:

Dimensions:

Operating Temp:

Mic Audio - 80mv max (Hi-Z)
Receive Audio - 250mv (nom)
PTT - 15v @ 50ma (max)

RS232 (+/- 3v min)
CMOS (2.5v min / 5v max)

+8 — 15 vdc @ 45ma (max)

Programmable

Input: RS-232/ CMOS
Output: AX-25 Packet
Data: DB-9S
Radio: RJ-11 (6)
Power: 2.1mm
1.1"x2.7"x 3.0"
-30C to +60C



Instructions For Optional Mic Adapter

Introduction: The TM-1 Mic Adapter Kit was created to
simplify attaching the TigerTrak to a mobile radior
tracking applications. The adapter provides a eaient
way to connect to the various mic lines without tteeed to
cut or splice any existing wiring. The Mic Adapisisimply
inserted in-line between the radio and the microgho
Inside the adapter there are a series of jumperiniafs that
allow you to bridge the appropriate mic lines overthe
TM-1 connector. Although this process is simplehaory,

it is extremely easy to make an error that couldeha
disastrous consequences! These instructions iaclad
worksheet to guide you through the process. ingortant
that you read this document thoroughly before h@gmand
then follow the instructions exactly to insure g These
instructions will take you through the followingegs:

1. Assemble the Mic Adapter printed circuit board.

2. Verify the radio’s microphone connector pin-out
using a multimeter.

3. Make a table showing tlw®rrectpin-out of the
microphone connector.

4. Complete the jumper wire diagram showing how
to install the jumpers.

5. Install the appropriate jumpers on the Mic
Adapter circuit board.

WARNING: Incorrect wiring could destroy both the TM-1
and your radio equipment! If after reviewing thiscument,
you are not absolutely certain that you are tectliyic
qualified to proceed, we recommend that you obtam
assistance of an experienced technician. Tigedson
assumes no responsibility for the use or misusehi
adapter. This document is intended only to provdsic
guidelines to a qualified technician. It is theleso
responsibility of the user to insure proper wiring.
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Assembling The PCB: Assembly and soldering of the Mic
Adapter circuit board is very straightforward. idta simple
matter of inserting the parts into the board assshim the
pictures and then carefully soldering all the pifEhe only
caution we might make is to be sure that each coeois
held tight against the board before you soldemight be a
good idea to solder just one or two pins and theubte
check the positioning of the part before solderiting
remainder. It iextremely difficulto reposition a part after it
is completely soldered, so take your time and dowahleck
your work! Be sure to index the round connectarextly.
Check the connector pin numbers and index notclinsiga
the pin numbers and index printed on the board.

Interface Cable: The next step in assembling the Mic
Adapter Kit is the wiring of the Interface Cabl&his is the
cable that connects your radio to the Mic Adapteart.
The reason that we want to wire this first is thatrovides a
useful tool for figuring out the microphone wiririg the
steps that follow. We have provided a short lerajtieight
conductor cable in the kit. The cable already thasRJ-45
connector installed on one end, so you will onlyddo
install the 8-pin round connector on the other.islbest to
make this cable as short as possible, so triml@gth
appropriately for the distance that you plan tateche Mic
Adapter from your radio. In wiring the connect®in #8
(center pin) is always the most difficult to soldeo we
would recommend that you wire the connector pims i
sequence starting with Pin #8 (reverse order). vBg/
careful not to fray any wires as they can cause tonshort
when the cable is flexed. It would be best to Useat
shrink” or insulating tubing on the pins, if it &vailable.
Wire the connector according to the wire colorstaswn in
the diagram below.
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Mic Adapter Radio Interface Cable - Wired straigtht-ough (pin 1 to pin 1, etc.)

Mic Connector: The next step is to determirier certain
the function of each pin on the mic connectorydfir radio
has a round 8-pin connector the process is vewigsir
forward, but if your radio uses a RJ-45 (telephdike)
connector, the process can be a little tricky! Wice either
connector youmusthave the Users Manual for your radio
available for reference.

To minimize the possibility of making a wiring mage, we
have provided a wiring table for you to completetire
Jumper Wire Diagram. As the correct signal is aeieed
for each microphone pin, you should record it ia thble.
You might want to use a pencil for this process;ase you
need to make a change or use the table for a eliffendio
later.

If your radio uses the 8-pin round connector, ybautd be
able to copy the signal names and their associptad
numbers directly from the radio manual into therappate
lines of the Jumper Wire Diagram. When copyings thi
information, be sure that you refer to the actualmumbers
given. Do not attempt to determine the pin nunfb@n any
illustration of the connector. When you are firidh it
would be a good idea to double check the accuragpur
information by testing continuity between chasssugd and
the pin that is supposed to be Ground on the cdéonec

If your radio uses an RJ-45 mic connector, you oann
assume that the pin numbers in the manual aredliste
correctly. If the manufacturer has not followee ihdustry
standard numbering conventions, the lines will bethe
correct sequence, but in reverse order (Pin #1n=#8j!
Unfortunately this is not at all uncommon. On anber of
occasions we have even found disagreement in th
numbering system between radio models from shene
manufacturer! You shouldeverassume the position of Pin
#1 on any RJ type connector, based on the diagnathei
manual. Since these lines often times have Accgsso
Voltage on them, wiring the connector incorrectincave
catastrophic results!

The best way to insure you have the correct widrder is
to verify with a multimeter where the Ground andTPdins
actually are on the connector. Because the RIS gre
dangerously close together and very fragile, wé wgée the
Interface Cable and Mic Adapter board to help midese

tests. Since the adapters RJ-45 and 8-pin roundecbors
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are wired in parallel (Pin #1 = Pin #1), you cae tie pins
on the back of the boards round connector forrigstirhese
pins are much easier to probe than an RJ-45 pirasndery
clearly numbered on the pc board. Turn the radié- @nd
attach the Mic Adapter board to your radio using@ th
Interface Cable.

Start the identification process by checking fontaity
between the radios chassis and the connector pib&uthat

is listed as Chassis Ground in your radio manu&lor
example: If the manual says that Pin #3 is Grouhdn
check continuity between the radio chassis andHing pin
(Pin #3) on the round connector. When making this
measurement, remember that you are looking for dZer
Ohms”. There will no doubt be some amount of auarity
between several other pins, but remember that tieeyou
are testing for is a “short” to ground! If you dofind
continuity on the pin that you tested, then the mpimbers
must be reversed in the radio manual. You cariyvtris by
testing the third pin from the other end (in ouample Pin
#6). You should find continuity on that pin if teder is in
fact reversed.

If you would like to up your confidence even funthgou
can turn your radio ON and test the PTT line. Yoadio
should be attached to an antenna or dummy loatthifotest,
since you will be transmitting briefly. In thissteyou will be
manually keying the transmitter by briefly shortitige PTT
line to Ground. If one is available, use a smallie resistor
(a few hundred ohms) to short the PTT line to Class
Ground (chassis - not the ground pin). The resistaot
really necessary, but a good idea just in caseayeshorting
the wrong pin! If the radio transmits, you candtsolutely
certain that you have the pin numbering correct.

Once you have established whether or not the pinthe
manual are listed in reverse order, you should retite
signal names into the appropriate lines of the &mvgire
Diagram. If the lines were not reversed, then gan enter
the signals exactly as they are numbered in yodiora
manual. If the connector numbers were reversesh émter
the signals into Jumper Wire Diagram in the reversker.



Mic Adapter RJ-11

Ground (Pwr)

®

Acc. Voltage
PTT ©
RX Audio ®
TX Audio ®
Ground (Mic)  (F)

)

Speaker Input

Mic Adapter RJ-45 / 8-Pin Rnd

Jumper Wire Diagram
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This means that the signal listed in the radio rahag Pin
#8 should be entered into the Jumper Wire Diagrert to
Pin #1. The signal listed in the manual as Pirsi#duld be
entered into the Jumper Wire Diagram as Pin #2sandn,
until all entries are complete.

Jumper Wire Diagram: Now that you have completed the
entries in the Jumper Wire Diagram, you are readgiraw
in the Jumpers that need to be installed on the Adiapter
pc board. This is simply a matter of matching THid-1
signals in the left column with the correspondiragio
signals in the right column and then drawing a ledween
them representing the jumper that you need tolins¥ou
may find that some of the signal names taken frioenradio
manual are not as descriptive as you might liké geaerally
the manual will also contain a brief descriptioneatch line
that will help you understand the function well agb to
make the match.

On occasion you may find a radio that does not idma
separate Mic Ground and Chassis (Pwr) Groundhisncase
you can simply jumper TM-1 pins “A” and “F” togethand
then connect them to the single radio ground. Thel
uses speaker audio (Pin “D") to determine if tharatel is
busy before it transmits. If your radio does noovide
speaker audio on the mic connector, you can deél thie
problem in several ways. First, if you are techlyjc
inclined, you could run the radios speaker audiartainused
(or unnecessary) pin on the mic connector. Thia iEce
solution but sometimes rather difficult to accorapli The
second solution is to run speaker audio from tlgosaAux
Spkr jack to the 3.5mm miniature phone jack on khie
Adapter board. This jack is connected to the teampoint
on the board marked “SQ”. The “SQ” terminal caarttbe
jumpered to the RX Audio pin to the TM-1 (Pin “D")The
drawback to this solution is that plugging into #ex Spkr
jack of most radios will disable the radios intdrapeaker.
If you are also using the radio for voice commutidgss, this
is a problem.
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About the only solution to that problem is to useexternal
speaker or modify the radios Aux Spkr jack so thatoes
not cut the internal speaker off. NOTE: Pin “BAct.
Voltage) going to the TM-1 is not required and dbdawot be
connected under normal circumstances. Refer tor Mel
Installation Manual for details about this pin.

Installing Jumpers: Using short lengths of the hookup wire
provided with the adapter kit, install jumpers be pc board
according to the diagram that you created abovéesd&
wires should be installed on the top side of thégard, so
that the jumpers can be checked or changed aendate
without removing the board from the enclosure.

Packaging the Mic Adapter: Tigertronics currently does
not supply a housing for the Mic Adapter board.islup to
the ingenuity of the user to find an appropriatekage
suitable for his purpose. For those who would like
package the board in a small plastic case, we wsudgest
looking at the Radio Shack case #270-1801. We favad
this case to work very well for “under dash” inkidbns. To
use this case, you will need to drill down or cfittbe four
standoffs on the floor to provide clearance for pleeboard.
You will of course also need to make the necedsalgs and
cutouts in the case for the Mic Adapter. The parbo
should be mounted to the floor of the case using #4
screws and short standoffs.

TigerTrak™ is a trademark of Tigertronics, Inc.
APRS® is a trademark of Bob Bruninga
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